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Informazioni importanti 
Salvo per quanto dichiarato espressamente nella licenza che accompagna 
un programma, Texas Instruments non rilascia alcuna garanzia, esplicita o 
implicita, incluse fra le altre le garanzie implicite di commerciabilità e di 
idoneità ad uno scopo particolare, per quanto riguarda programmi o 
materiali cartacei e rende disponibili tali materiali esclusivamente su base 
"tal quale." In nessun caso Texas Instruments è responsabile verso 
chicchessia di danni speciali, collaterali, incidentali o consequenziali in 
relazione con o derivanti dall'acquisto o dall’uso di questi materiali, e la 
sola ed esclusiva responsabilità di Texas Instruments, indipendentemente 
dalla forma dell'azione, non supera l'importo indicato nella licenza per il 
programma. Inoltre Texas Instruments non è responsabile di 
rivendicazioni di alcun genere contro l'uso di questi materiali da parte di 
chiunque.

Licenza 
Leggere per intero la licenza installata in C:\Program Files\TI 
Education\TI-Nspire.

© 2008 Texas Instruments Incorporated

Macintosh®, Windows®, Excel®, Vernier EasyLink®, EasyTemp®, 
Go!®Link, Go!®Motion, e Go!®Temp sono marchi dei rispettivi 
proprietari.
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Utilizzo del software per il collegamento al 
PC TI-Nspire™

Guida introduttiva al software per il 
collegamento al PC TI-Nspire™ 
Il software per il collegamento al PC TI-Nspire™ consente di:

• Trasferire documenti tra il computer e un palmare TI-Nspire™.

• Catturare immagini da uno schermo del palmare TI-Nspire™ e 
utilizzarle in documenti di TI-Nspire™ e del computer.

• Creare un backup dei documenti di un palmare in un unico file sul 
computer e successivamente ripristinare i documenti.

• Aggiornare il software del sistema operativo (SO) in un palmare 
TI-Nspire™.

Apertura del software per il collegamento al PC TI-Nspire™
1. Accertarsi di aver collegato un palmare TI-Nspire™ al computer.

Nota: il software per il collegamento al PC TI-Nspire™ funziona solo 
con il palmare TI-Nspire™. Non può essere utilizzato per comunicare 
con altri palmari o calcolatrici TI, come ad esempio una TI-92 Plus. Per 
comunicare con questi palmari o calcolatrici, utilizzare il software 
TI Connect™ (versione 1.6 o successiva) invece del software per il 
collegamento al PC TI-Nspire™.

2. Fare doppio clic sull'icona del software per il collegamento al PC 

TI-Nspire™  sul desktop.

Viene visualizzato un elenco di palmari collegati da cui è possibile 
selezionarne uno.

Nota: il computer può comunicare con un solo palmare alla volta.
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3. Se ci sono più palmari collegati, fare clic su quello da collegare.

4. Fare clic su Select (Seleziona).

Viene visualizzata la scheda Explorer (Esplora risorse).

Selezione tra più palmari
Quando si utilizza il software per il collegamento al PC TI-Nspire™ è 
possibile passare in qualsiasi momento a una palmare diverso.

1. Collegare il palmare al computer.
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2. Fare clic su  nell'angolo inferiore della finestra del software per il 
collegamento al PC TI-Nspire™.

3. Fare clic sul nome del palmare, quindi fare clic su Select (Seleziona).

Esame del contenuto del palmare
La scheda Esplora risorse del software per il collegamento al PC 
TI-Nspire™ consente di visualizzare il contenuto di un palmare collegato 
e di trasferire (copiare) documenti tra il computer e il palmare, nonché di 
rinominare ed eliminare documenti del palmare.

À

Â

Á

Ã
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À Intestazioni di colonna – Nella vista dettagliata fare clic su 
un'intestazione per ordinare l'elenco. Fare nuovamente clic 
sull'intestazione per invertire l'ordine dell'elenco.

Á File archiviati nella cartella del computer selezionata.

Â Barra di divisione – Trascinare verso l'alto o il basso la barra di 
divisione per visualizzare più o meno file.

Ã Documenti archiviati nella cartella del palmare selezionata.

Selezione del formato di visualizzazione

Nota: è possibile fare clic sul pulsante Aggiorna  in qualsiasi 
momento per aggiornare gli elenchi di file e cartelle.

Fare clic su View (Visualizza) > Detail View (Vista dettagliata) 

oppure fare clic su  per visualizzare i dettagli dei file e per 
ordinare l'elenco.

Fare clic su View (Visualizza)> List View (Vista elenco) oppure fare 

clic su  per visualizzare un elenco solo dei nomi file.

Fare clic su View (Visualizza) > Show Folder View (Mostra vista 
cartelle) per visualizzare la struttura delle cartelle del computer e 
del palmare in un riquadro separato, sulla sinistra.

Fare clic su View (Visualizza) > Hide Folder View (Nascondi vista 
cartelle) per nascondere la struttura delle cartelle.

Visualizzazione del contenuto di un palmare
1. Se Esplora risorse non è visibile, fare clic sulla relativa scheda.

2. Nella vista cartelle, fare clic su qualsiasi cartella per visualizzarne il 
contenuto nell'elenco sulla destra.

Prima di copiare documenti o cartelle su un palmare
• Con l'eccezione dei file .fig creati con Cabri II Plus e dei file .edc creati 

con  LearningCheck™ Creator, il software per il collegamento al PC 
TI-Nspire™ consente di copiare su un palmare esclusivamente i 
documenti del palmare TI-Nspire. Se si tenta di copiare 
involontariamente altri tipi di file, o una cartella contenente altri tipi 
di file, il software per il collegamento al PC TI-Nspire™ lo notifica e 
annulla l'operazione di copia.

• Quando si copia un file .fig del Cabri II Plus sul palmare, il file viene 
convertito in un documento TI-Nspire™ (.tns) a due pagine:
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– La prima è una pagina di Graphs & Geometry con oggetti 
convertiti.

– La seconda è una pagina di Notes con l'elenco degli elementi che 
non sono stati correttamente convertiti. 

• La cartella Documenti del palmare può contenere solo sottocartelle. È 
possibile copiare file in queste sottocartelle, ma non direttamente 
nella cartella Documenti.

• Quando si copia una cartella sul palmare, essa deve essere copiata 
nella cartella Documenti. Non può essere copiata in una sottocartella.

• È possibile trascinare file e cartelle del palmare solo in cartelle che si 
trovano all'interno della finestra del software.- Non è possibile 
trascinarli all'esterno della finestra.

Copia di documenti mediante trascinamento
È possibile trascinare il mouse per copiare documenti tra un palmare e il 
computer o tra due cartelle sul computer.

1. Fare clic sul documento che si desidera copiare.

Nota: è possibile selezionare più documenti contemporaneamente 
tenendo premuto il tasto Ctrl  (tasto “ in Macintosh®) e facendo 
clic su ciascuno di essi.

2. Trascinare la selezione e rilasciarla sulla destinazione desiderata.

Gli elementi selezionati vengono copiati nella destinazione.

Nota: se un documento con lo stesso nome esiste già nella 
destinazione, viene chiesto se si desidera sostituirlo.

Copia di cartelle mediante trascinamento
È possibile trascinare il mouse per copiare cartelle tra un palmare e il 
computer.

1. Fare clic sulla cartella che si desidera copiare.

Nota: è possibile selezionare più cartelle contemporaneamente 
tenendo premuto il tasto Ctrl (tasto “ in Macintosh®) e facendo clic 
su ciascuna di esse.
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2. Trascinare la selezione e rilasciarla sulla destinazione desiderata.

Gli elementi selezionati vengono copiati nella destinazione.

Nota: se una cartella con lo stesso nome esiste già nella 
destinazione, viene chiesto se si desidera sostituirla.

Copia di documenti e cartelle mediante la funzione Incolla
È possibile utilizzare gli Appunti per copiare documenti e cartelle. Per 
spostare un elemento, invece, copiarlo e successivamente eliminare 
l'originale.

1. Fare clic sul documento o la cartella da copiare.

Nota: è possibile selezionare più elementi contemporaneamente 
tenendo premuto il tasto Ctrl (tasto “ in Macintosh®) e facendo clic 
su ciascuno di essi.

2. Fare clic su (Edit) Modifica > Copy (Copia) per copiare gli elementi 
selezionati negli Appunti.

3. Fare clic su una cartella per selezionarla come destinazione.

4. Fare clic su Edit (Modifica) > Paste (Incolla).

Esplora risorse copia gli elementi nella cartella di destinazione.

Nota: se la cartella di destinazione contiene già un documento con lo 
stesso nome di quello che si sta copiando, è possibile scegliere di 
sostituire il documento esistente o di annullare l'operazione.

Annullamento di un trasferimento in corso
Con la finestra Trasferimento file visualizzata, è possibile annullare un 
trasferimento. Verrà annullato il trasferimento solo dei file che non sono 
ancora stati trasferiti.

Nella finestra Trasferimento file, fare clic su Annulla.

Creazione di una nuova cartella sul palmare
È possibile creare una nuova cartella nella cartella Documenti del 
palmare. Non è possibile creare una cartella all'interno di una 
sottocartella del palmare.
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1. Fare clic sul nome del palmare nel browser di TI-Nspire™.

2. Fare clic su File > New folder (Nuova cartella).

Il software per il collegamento al PC TI-Nspire™ crea una cartella 
denominata New Folder (Nuova cartella) e ne evidenzia il nome per 
consentirne la modifica.

3. Digitare un nome per la nuova cartella e premere Invio.

Attribuzione di nuovi nomi a documenti e cartelle di un 
palmare
Nota: il software per il collegamento al PC TI-Nspire™ non consente di 
modificare l'estensione di un nome file.

1. Fare clic sul nome del documento o della cartella, quindi fare clic su 
File >Rename (Rinomina).

Intorno al nome viene visualizzato un bordo a indicare che può 
essere modificato.

2. Digitare il nuovo nome e premere Invio.

Eliminazione di documenti dal palmare
Quando si elimina un documento, lo si cancella definitivamente e non 
può essere recuperato.

Fare clic sul nome del documento, quindi fare clic su File > Delete 
(Elimina).

Prima di eliminare il documento, Esplora risorse chiede di 
confermare l'eliminazione.

Note:

• È possibile selezionare più documenti da eliminare 
contemporaneamente tenendo premuto il tasto Ctrl  (tasto “ in 
Macintosh®) e facendo clic su ciascuno di essi. Quando si fa clic su 
Elimina, Esplora risorse  elimina tutti i documenti selezionati.

• Non è possibile eliminare file che sono sul computer.
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Eliminazione di una cartella dal palmare
Quando si elimina una cartella, la cartella e tutti i documenti in essa 
contenuti vengono cancellati definitivamente e non possono essere 
recuperati.

Fare clic sul nome della cartella, quindi fare clic su File > Delete 
(Elimina).

Prima di eliminare la cartella, Esplora risorse chiede di confermare 
l'eliminazione.

Note:

• È possibile selezionare più cartelle da eliminare 
contemporaneamente tenendo premuto il tasto Ctrl  (tasto “ in 
Macintosh®) e facendo clic su ciascuna di esse. Quando si fa clic su 
Elimina, Esplora risorse elimina tutti i documenti selezionati.

• Non è possibile eliminare dal palmare la cartella Documenti.

• Non è possibile eliminare cartelle che sono sul computer.

Cattura di schermi del palmare
La scheda Screen Capture (Cattura schermo) consente di catturare 
immagini dello schermo di un palmare TI-Nspire™ collegato. 
Successivamente, sarà possibile ridimensionare le immagini, aggiungere 
o rimuovere un bordo, copiarle in documenti o salvarle come file di 
immagini sul computer.
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À Scheda Screen Capture (Cattura schermo) 

Á Barra degli strumenti di Cattura schermo

Â Schermi del palmare catturati (vista miniature)

A ciascuno schermo viene aggiunto automaticamente un bordo 
rimovibile. La dimensione di uno schermo catturato è 326 pixel 
(larghezza) per 246 pixel (altezza), con o senza bordo.

Cattura di uno schermo
1. Accertarsi che il palmare sia acceso e collegato correttamente al 

computer.

2. Sul palmare, visualizzare lo schermo da catturare.

3. Fare clic sulla scheda Cattura schermo nella finestra del software per 
il collegamento al PC TI-Nspire™.

4. Fare clic su File > Take screenshot (Cattura schermo) oppure fare 

clic su .

La finestra Cattura schermo mostra l'immagine catturata.

À ÂÁ
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Nota: se l'ultima volta è stato rimosso il bordo da uno schermo, i nuovi 
schermi appariranno senza bordo. Se invece il bordo è stato aggiunto, i 
nuovi schermi appariranno con il bordo.

Visualizzazione di miniature di schermi catturati
È possibile visualizzare le immagini singolarmente oppure 
contemporaneamente, come un gruppo di immagini, in formato 
miniaturizzato. Sotto ciascuna immagine viene visualizzato un nome di 
riferimento. La vista miniature consente inoltre di selezionare 
contemporaneamente più immagini dello schermo per la copia, il 
salvataggio, ecc.
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Per visualizzare gli schermi come miniature, fare clic su View 

(Visualizza) > Thumbnails (Miniature) oppure fare clic su .

Per visualizzare gli schermi singolarmente, fare clic su View 
(Visualizza) > Single Screen (Singolo schermo) oppure fare clic su 

.

Selezione di più schermi
Questa funzione consente di applicare una modifica 
contemporaneamente a tutti gli schermi selezionati. Ad esempio, è 
possibile selezionare diversi schermi e in seguito ridimensionarli o 
rimuoverne i bordi contemporaneamente.

1. Se necessario, fare clic su  per visualizzare la vista miniature.

2. Utilizzare uno dei seguenti metodi per selezionare gli schermi.

• Fare clic su Modifica (Edit) > Seleziona tutto (Select All)  
oppure premere Ctrl+A (“+A in Macintosh®)  per selezionare 
tutti gli schermi catturati.

• Fare clic sulla prima immagine da selezionare, quindi tenere 
premuto il tasto Ctrl (“ in Macintosh®)  sulla tastiera del 
computer mentre si fa clic su ciascuna immagine aggiuntiva

• Selezionare un intervallo di immagini facendo clic sulla prima 
immagine dell'intervallo, quindi tenere premuto il tasto Maiusc 
e fare clic sull'ultima immagine dell'intervallo.

Ridimensionamento degli schermi
È possibile salvare la versione ingrandita o ridotta di un'immagine dello 
schermo applicando la funzione Ingrandisci o Riduci all'immagine prima 
di salvarla.

Per visualizzare un'immagine dello schermo ingrandita, fare clic su 

View (Visualizza) > Zoom In (Ingrandisci) oppure fare clic su .

Per visualizzare un'immagine dello schermo rimpicciolita, fare clic su 

View (Visualizza) > Zoom Out (Riduci) oppure fare clic su .
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Aggiunta o rimozione del bordo
Il pulsante della barra degli strumenti per l'aggiunta o la rimozione del 

bordo sarà  (aggiunta) o  (rimozione) a seconda che 
nell'immagine selezionata il bordo sia assente o meno.

Nota: se l'ultima volta è stato rimosso il bordo da uno schermo, i nuovi 
schermi appariranno senza bordo. Se invece il bordo è stato aggiunto, i 
nuovi schermi appariranno con il bordo.

1. Fare clic sull'immagine catturata per selezionarla.

2. Fare clic su Edit (Modifica) > Remove Border (Rimuovi bordo) 

oppure fare clic su  per rimuovere il bordo.

– Oppure – 
Fare clic su Edit (Modifica) > Add Border (Aggiungi bordo) oppure 

fare clic su  per aggiungere un bordo.

Aggiunta o rimozione del bordo in un gruppo di immagini
1. Fare clic su View (Visualizza) > Thumbnails (Miniature) oppure fare 

clic su .

2. Selezionare il gruppo di immagini. È possibile:

• Fare clic sulla prima immagine da selezionare, quindi tenere 
premuto il tasto Ctrl(“ in Macintosh®)  sulla tastiera del 
computer mentre si fa clic su ciascuna immagine aggiuntiva.

• Selezionare un intervallo di immagini facendo clic sulla prima 
immagine dell'intervallo, quindi tenere premuto il tasto Maiusc 
e fare clic sull'ultima immagine dell'intervallo.

3. Fare clic su Edit (Modifica) > Remove Border (Rimuovi bordo) 

oppure fare clic su  per rimuovere il bordo.

– Oppure – 
Fare clic su Edit (Modifica) > Add Border (Aggiungi bordo) oppure 

fare clic su  per aggiungere un bordo.
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Come spostarsi tra le immagini dello schermo
Per visualizzare l'immagine dello schermo precedente, fare clic su 
View (Visualizza) > Previous Screen (Schermo precedente) oppure 

fare clic su .

Per visualizzare l'immagine dello schermo successiva, fare clic su 
View (Visualizza) > Next Screen (Schermo successivo) oppure fare 

clic su .

Salvataggio di schermi catturati come file del computer
È possibile salvare sul computer immagini dello schermo in formato TIF, 
GIF o JPEG. Gli schermi vengono salvati nella cartella Documenti, se non 
viene specificata una destinazione diversa per il salvataggio. Tutti gli 
schermi vengono salvati con le dimensioni con cui sono visualizzati al 
momento del salvataggio.

1. Selezionare lo schermo o gli schermi catturati da salvare.

2. Fare clic su File > Save Screen (Salva schermo) oppure fare clic su 

.

3. Nella finestra di dialogo:

a) Spostarsi sulla cartella in cui si desidera memorizzare il file 
dello schermo catturato.

b) Selezionare il tipo di file per il formato immagine 
appropriato.

c) Digitare un nome file. Utilizzare un nome descrittivo 
dell'immagine dello schermo.

d) Fare clic su Save (Salva).

Nota:

• Se l'immagine dello schermo selezionata è già stata salvata, facendo 

clic su File > Save Screen (Salva schermo) oppure su  si 
sovrascrive il file precedente. Per salvare il file in una cartella diversa, 
con un nome file diverso, oppure con un formato diverso, occorre 
fare clic su File > Save Screen As (Salva schermo con nome).
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• Per salvare contemporaneamente tutte le immagini, fare clic su File > 
Save All Screens (Salva tutti gli schermi). In questo caso, nella 
finestra Salva tutto si seleziona la cartella in cui verranno salvati i file, 
ma non si specifica alcun nome. Ogni immagine dello schermo viene 
salvata con il proprio nome predefinito. Se un file con lo stesso nome 
esiste già nella destinazione, viene chiesto se si desidera sostituirlo.

• Se ci sono immagini di schermi non salvate all'uscita dal software per 
il collegamento al PC TI-Nspire™, viene richiesto di salvarle. Se si 
sceglie di salvare, le immagini verranno archiviate nella cartella 
TI-Nspire/Screen Captures (Immagini catturate).

Copia di un'immagine dello schermo in un'applicazione del 
computer mediante trascinamento
1. Modificare le dimensioni della finestra del software per il 

collegamento al PC TI-Nspire™ e della finestra dell'altra applicazione 
in modo da poterle vedere entrambe sullo schermo del computer.

2. Nella finestra del software per il collegamento al PC TI-Nspire™, fare 
clic sullo schermo catturato per selezionarlo.

3. Trascinare lo schermo dal software per il collegamento al PC 
TI-Nspire™ e rilasciarlo nell'altra applicazione.

Copia di un'immagine dello schermo mediante la funzione 
Incolla
È possibile copiare e incollare uno schermo catturato in un'altra 
applicazione che consente di incollare immagini.

1. Fare clic sullo schermo catturato per selezionarlo.

2. Premere Ctrl+C (“+C in Macintosh®)  per copiare l'immagine negli 
Appunti.

3. Fare clic sull'altra applicazione nel punto in cui si desidera far 
apparire l'immagine.

4. Premere Ctrl+V (“+V in Macintosh®)  per incollare l'immagine 
nell'applicazione.

Backup sul computer dei documenti del palmare
Il software per il collegamento al PC TI-Nspire™ consente di salvare sul 
computer tutti i documenti di un palmare in un unico file di backup. È 
possibile effettuare quanti backup si desidera. Successivamente, sarà 
possibile ripristinare i documenti sul palmare.
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Creazione di un backup immediato
Quando si utilizza la funzione di backup immediato, il software per il 
collegamento al PC TI-Nspire™ crea un file di backup sul computer nella 
cartella TI-Nspire/Backup. Il nome del file include l'anno, il mese, il 
giorno, l'ora (con i minuti e i secondi) in cui è stato effettuato il backup.

Fare clic su Tools (Strumenti) > One Click Backup (Backup 
immediato).

Durante il backup viene visualizzato un messaggio che ne indica la 
progressione.

Creazione di un file di backup in una cartella specifica
Utilizzare questo metodo per specificare la cartella e il file da utilizzare 
per il backup.

1. Fare clic su Tools (Strumenti) > Backup.

Viene visualizzata una finestra di dialogo che consente di specificare 
un file di backup.

2. Spostarsi sulla cartella in cui si desidera creare il file di backup.

3. Digitare un nome per il file, oppure fare clic su un file di backup 
esistente per sostituirlo.

4. Fare clic su Save (Salva).

Durante il backup viene visualizzato messaggio che ne indica la 
progressione.

Ripristino di documenti del palmare da un file di backup
1. Fare clic su Tools (Strumenti) > Restore (Ripristina).
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Viene visualizzata una finestra di dialogo che consente di selezionare 
un file di backup.

2. Spostarsi sulla cartella che contiene il file di backup.

3. Fare clic sul file.

4. Fare clic su Restore (Ripristina).

Viene visualizzato un messaggio che avvisa che l'operazione di 
ripristino sostituirà tutti i documenti presenti sul palmare.

5. Fare clic su OK per procedere con il ripristino.

Durante il processo di ripristino viene visualizzato messaggio che ne 
indica la progressione.

Se non è possibile effettuare il ripristino da un file di 
backup
In alcuni casi, il palmare può non disporre di memoria sufficiente per i file 
ripristinati. Il software per il collegamento al PC TI-Nspire™ rileva la 
disponibilità e consente di espandere il file di backup in singoli 
documenti sul computer. Successivamente, sarà possibile trasferire 
selettivamente i documenti sul palmare utilizzando le opzioni Copia e 
Sposta abituali.

Visualizzazione dei dettagli sul palmare
Il software per il collegamento al PC TI-Nspire™ Computer Link può 
visualizzare le seguenti informazioni relative al palmare:

• tipo palmare e ID

• versione del sistema operativo (SO)
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• ID calcolatrice

• versione di boot

• capacità di memoria totale

• spazio utilizzato

• spazio libero

• stato batterie

Per visualizzare i dettagli del palmare:

1. collegare il palmare da visualizzare.

2. Aprire il software per il collegamento al PC TI-Nspire™ Computer 
Link.

3. Fare clic su Strumenti > Informazioni palmare.

Compaiono le informazioni relative al palmare. Si può usare il mouse 
per evidenziare e copiare il testo.

Nota: se si riceve un messaggio di errore che dice “Il palmare non 
risponde,” controllare che il palmare sia collegato correttamente e 
riprovare.

Aggiornamento del software e del SO del palmare
Dal menu Help (?), è possibile seguire alcune importanti operazioni e 
ottenere informazioni utili che possono aiutarvi a usare il dispositivo in 
modo più produttivo. È possibile:

• registrare il prodotto

• verificare l'eventuale presenza di aggiornamenti del software e del 
SO (gli aggiornamenti del SO del palmare sono disponibili solo nei 
software Connect-to-Class™ e nel software di collegamento al PC TI-
Nspire™ Computer Link)

• scaricare i manuali più recenti

• visitare siti informativi su Internet per migliorare la propria 
competenza nel prodotto

• verificare la versione del software utilizzata

È possibile scaricare la versione più recente del software di TI-Nspire™ o 
del SO per il palmare o ancora del software del desktop. È possibile 
scaricare software in qualsiasi software TI-Nspire™. Si possono scaricare 
aggiornamenti del SO soltanto nel software Connect-to-Class™ o nel 
software di collegamento al PC TI-Nspire™ Computer Link.
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Nota: a parte la visualizzazione della versione corrente del software, per 
eseguire le altre operazioni indicate occorre essere collegati a Internet. 
Non occorre invece essere collegati a Internet per visualizzare la versione 
corrente del software come illustrato nel comando Informazioni su.

Le immagini illustrate in questo capitolo sono rappresentative dei menu 
Help (?) effettivamente disponibili. Questi possono variare, a seconda del 
software TI-Nspire™ utilizzato.

Registrazione del prodotto
Per registrare il prodotto:

1. avviare il software del desktop. Accertarsi di disporre di un accesso a 
Internet.

2. Fare clic su Help (?) > Registra.

Si apre il browser di Internet e quindi il collegamento di registrazione del 
software.

Scaricamento di manuali
Scaricare la guida del prodotto può aiutarvi a:

• trovare informazioni in modo facile e rapido

• scoprire come eseguire le nuove operazioni in modo più facile ed 
efficiente

• migliorare la propria competenza con le applicazioni TI-Nspire™

• eliminare le tipiche frustrazioni legate all'uso di un libro

Per scaricare manuali:

1. avviare il software del desktop. Accertarsi di disporre di un accesso a 
Internet.

2. Fare clic su Help (?) > Scarica ultima versione del Manuale ...
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Il browser Internet si apre su una pagina Web che guida l'utente allo 
scaricamento dei manuali più recenti.

Accesso a siti informativi su Internet
Il software contiene collegamenti rapidi ai seguenti siti. In questi siti, è 
possibile reperire informazioni in merito alle modalità d'utilizzo dei 
prodotti TI oltre a lezioni, test e altre attività didattiche condivise dai 
docenti.

• Il sito di TI Education Technology si trova all'indirizzo 
http://education.ti.com

• L'Activities Exchange è un forum nel quale è possibile cercare per 
argomento le attività didattiche condivise dai docenti

Visita del sito TI Education Technology
1. Avviare il software del desktop. Accertarsi di disporre di un accesso a 

Internet.

2. Fare clic su Help (?) > Visita education.ti.com.

Il browser Internet si apre sulla home page di Education Technology. 
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Visitare l'Activities Exchange
1. Avviare il software del desktop. Accertarsi di disporre di un accesso a 

Internet.

2. Fare clic su Help (?) > Visita Activities Exchange.

Il browser Internet si apre su una pagina Web nella quale 
è possibile selezionare una lingua e un'impostazione 
regionale. Sulla base della selezione effettuata, si apre 
una pagina specifica dell'Activities Exchange.

Nota: le attività possono variare a seconda dei partecipanti all'Activities 
Exchange nella lingua selezionata.

Aggiornamento del SO del palmare

Preparazione all'aggiornamento
Attenzione: aggiornando il sistema operativo si cancellano tutte le 
applicazioni e i file dalla TI-84. Prima di installare un aggiornamento del 
SO, si dovrebbe utilizzare TI Connect per eseguire il backup di tutte le 
applicazioni e i file della TI-84 su un computer. Una volta completato 
l'aggiornamento del SO, sarà possibile copiare nuovamente i file e le 
applicazioni sul palmare.

Se sul palmare ricevente non c'è spazio sufficiente per l'aggiornamento, 
viene inviato un messaggio di notifica all'unità inviante. È possibile che 
un'installazione del SO operativo abbia una ripercussione sui documenti 
solo se il SO dell'unità ricevente è danneggiato. In questo caso il 
ripristino del SO potrebbe danneggiare i documenti. È buona pratica 
eseguire il backup dei documenti e delle cartelle importanti prima di 
installare e aggiornare il sistema operativo.

Vedere sotto le informazioni importanti riguardanti le batterie prima di 
eseguire l'aggiornamento del SO.
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informazioni importanti sul download
Si dovrebbero sempre inserire batterie nuove prima di scaricare un 
aggiornamento del software o del SO.

In modo scaricamento del SO, la funzione di spegnimento automatico 

Automatic Power Down  (APD) non è attiva. Se si lascia il dispositivo in 
modalità download per lungo tempo prima di avviare il processo, si 
potrebbero scaricare le batterie. Di conseguenza, si dovranno inserire 
batterie nuove prima di procedere al download.

Scaricamento automatico di aggiornamenti del SO del 
palmare
Ecco alcune note importanti da ricordare in merito all'aggiornamento del 
software:

• occorre disporre di una sessione attiva del software di collegamento 
al PC TI-Nspire™ Computer Link perché il sistema fornisca notifiche 
automatiche della disponibilità di una versione più recente del SO. 
Tuttavia, è possibile usare il software di collegamento al PC 
TI-Nspire™ Computer Link o il software Connect-to-Class™ per 
controllare manualmente l'eventuale presenza di aggiornamenti del 
SO.

• Se si è collegati a Internet il sistema notifica la presenza di eventuali 
aggiornamenti del software TI-Nspire™ non appena si collega il 
palmare al software del desktop.

• Il controllo automatico si verifica una volta per ogni sessione del 
software di collegamento al PC TI-Nspire™ Computer Link, al 
momento della prima connessione del palmare. Se si scollega il 
palmare e quindi lo si ricollega durante la stessa sessione, il controllo 
non viene eseguito nuovamente.

• Se il sistema è aggiornato, non si riceve alcuna notifica.

• Se non si vogliono ricevere notifiche automatiche, è comunque 
possibile disattivare questa funzionalità.

Dopo che il sistema ha controllato l'eventuale presenza di un 
aggiornamento del SO, se effettivamente risulta presente una versione 
più recente, compare la seguente finestra di dialogo:
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Per installare l'aggiornamento del SO e gestite le notifiche di 
aggiornamento:

1. controllare di essere collegati a Internet.

2. Selezionare le opzioni desiderate. È possibile effettuare le 
operazioni che seguono in qualsiasi combinazione:

• installazione del SO

• salvataggio di una copia del SO per una successiva installazione 
o per uso personale

• cambiamento dell'impostazione di Notifica automatica

3. Per disattivare le notifiche automatiche, deselezionare Controlla 
automaticamente gli aggiornamenti.

4. Fare clic su Sfoglia per modificare la posizione di salvataggio della 
copia del SO. Usare il browser per selezionare una nuova posizione.

5. Fare clic su Continua per salvare le impostazioni e iniziare lo 
scaricamento.

Si apre una casella messaggio che indica la progressione dello 
scaricamento.

Nota: se si riceve un messaggio di errore di connessione, controllare il 
collegamento a Internet e riprovare.

Scaricamento manuale degli aggiornamenti del SO
Per controllare l'eventuale presenza di aggiornamenti del SO del 
palmare:

1. controllare di essere collegati a Internet.
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2. Collegare il palmare da visualizzare.

3. Aprire il software di collegamento al PC TI-Nspire™ Computer Link o 
il software Connect-to-Class™.

4. Selezionare il palmare da aggiornare.

5. Fare clic su Help (?) > Controlla aggiornamenti del SO del palmare.

Il software verifica l'eventuale presenza di aggiornamenti. Se il 
sistema risulta aggiornato, viene visualizzata la seguente finestra di 
dialogo.

6. Fare clic su OK per chiudere la finestra.

7. Se è disponibile una nuova versione, viene visualizzata la seguente 
finestra di dialogo.
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8. Selezionare le opzioni desiderate. È possibile effettuare le 
operazioni che seguono in qualsiasi combinazione:

• installazione del SO

• salvataggio di una copia del SO per una successiva installazione 
o per uso personale

• cambiamento dell'impostazione di Notifica automatica

9. Per disattivare le notifiche automatiche, deselezionare Controlla 
automaticamente gli aggiornamenti.

10. Fare clic su Sfoglia per modificare la posizione di salvataggio della 
copia del SO. Usare il browser per selezionare una nuova posizione.

11. Fare clic su Continua per salvare le impostazioni e iniziare lo 
scaricamento.

Si apre una casella messaggio che indica la progressione dello 
scaricamento.

Nota: se si riceve un messaggio di errore di connessione, controllare il 
collegamento a Internet e riprovare.

Scaricamento automatico degli aggiornamenti software
Ecco alcune note importanti da ricordare in merito all'aggiornamento del 
software:

• se si è collegati a Internet e l'opzione di notifica automatica è 
attivata, il sistema notifica la presenza di eventuali aggiornamenti 
del software TI-Nspire™ all'apertura del software desktop. È inoltre 
possibile controllare manualmente la presenza di aggiornamenti.

• Il controllo automatico si verifica ad ogni apertura del software.
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• Se il sistema è aggiornato, non si riceve alcuna notifica.

• Se non si vogliono ricevere notifiche automatiche, è comunque 
possibile disattivare questa funzionalità.

Dopo che il sistema ha controllato l'eventuale presenza di un 
aggiornamento, se effettivamente risulta presente una versione più 
recente, compare la seguente finestra di dialogo:

Per installare l'aggiornamento del software e gestite le notifiche di 
aggiornamento:

1. controllare di essere collegati a Internet.

2. Per disattivare le notifiche automatiche, deselezionare Controlla 
automaticamente gli aggiornamenti.

3. Fare clic su Aggiorna per salvare le impostazioni e iniziare lo 
scaricamento.

Si apre una casella messaggio che indica la progressione dello 
scaricamento.

Nota: se si riceve un messaggio di errore di connessione, controllare il 
collegamento a Internet e riprovare.

Scaricamento manuale degli aggiornamenti del software
Per controllare gli aggiornamenti del software:

1. controllare di essere collegati a Internet.

2. Aprire TI-Nspire™, il software di collegamento al PC TI-Nspire™ 
Computer Link o il software Connect-to-Class™.

3. Fare clic su Help (?) > Controlla gli aggiornamenti software.
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Il software verifica l'eventuale presenza di aggiornamenti. Se il 
software risulta aggiornato, viene visualizzata la seguente finestra di 
dialogo.

4. Fare clic su OK per chiudere la finestra.

5. Se è disponibile una nuova versione, viene visualizzata la seguente 
finestra di dialogo.
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6. Per disattivare le notifiche automatiche, deselezionare Controlla 
automaticamente gli aggiornamenti.

7. Fare clic su Aggiorna per dare il via allo scaricamento, oppure su 
Chiudi per abbandonare l'aggiornamento.

Si apre una casella messaggio che indica la progressione dello 
scaricamento.

Nota: se si riceve un messaggio di errore di connessione, controllare il 
collegamento a Internet e riprovare.
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Informazioni sul servizio di manutenzione e 
riparazione del prodotto TI e sulla garanzia

Informazioni sul 
prodotto e sui servizi 
TI

Per ulteriori informazioni sui prodotti e servizi TI, 
potete contattare TI via e-mail o visiti l'indirizzo 
Internet di TI.

Indirizzo e-mail: ti-cares@ti.com
Indirizzo internet: education.ti.com

Informazioni sul 
servizio di 
manutenzione e 
riparazione e sulla 
garanzia

Per informazioni sulla durata e le condizioni della 
garanzia o sul servizio di manutenzione e 
riparazione del prodotto, fate riferimento alla 
dichiarazione di garanzia allegata al presente 
prodotto oppure contattate il vostro rivenditore/
distributore Texas Instruments locale.

mailto:ti-cares@ti.com
http://education.ti.com
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